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[ Please read this manual before operating this scanner. J




Connecting the Scanner to a Computer

Connect the CR-190i to a computer as follows. Make sure to install the II‘ Install the software

software before connecting the scanner to a computer.

e |f you connect the computer and turn ON the CR-190i before
installing the software, the following wizard screen appears. If this

Install the Scanning Utility for CR-190i in the setup disc provided
with the CR-190i. (See “Installing the Software,” on p. 19.)

happens, click [Cancel], turn OFF the CR-190i, and then install the IZ' Connect the scanner to a computer
software. Connect the CR-190i and the computer with a USB. (See
The following wizard screen is an example in Windows Vista. When a “Connecting the Scanner to a Computer,” on p. 20.)
similar wizard screen appears in Windows XP/7, click [Cancel].
PP / : ] @ Turn ON the power
[27] Found New Hardware = Turn ON the power of the CR-190i. (See “Turning ON the Power,”
onp.21.
Windows needs to install driver software for your CANON P )
CR-190i E Automatically installing the device driver

The device driver is installed automatically when Windows

3 recognizes the CR-190i as new hardware. (See p. 22.)

¥ Locate and install driver software (recommended)
Windows will guide you through the process of installing driver software
for your device.

* Ask me again later

‘Windows will ask again the next time you plug in your device or log on.

® Don't show this message again for this device
Your device will not function until you install driver software.

Cancel

Wizard Screen (Windows Vista)




READ CAREFULLY BEFORE OPENING THE
SEALED DISK PACKAGE

CANON SOFTWARE LICENSE AGREEMENT
IMPORTANT-READ THIS AGREEMENT BEFORE
OPENING THE SEALED DISK PACKAGE! BY
OPENING THE SEALED DISK PACKAGE, YOU ARE
DEEMED TO AGREE TO BE BOUND BY THIS
AGREEMENT.

This legal document is a license agreement between you and CANON
ELECTRONICS INC. (“Canon”). BY OPENING THE SEALED DISK
PACKAGE, YOU ARE DEEMED TO AGREE TO BE BOUND BY THE
TERMS OF THIS AGREEMENT. |F YOU DO NOT AGREE T0 THE
TERMS OF THIS AGREEMENT, DO NOT OPEN THE SEALED DISK
PACKAGE AND PROMPTLY RETURN THE CANON SCANNER, THE
DISK PACKAGE CONTAINING SCANNER DRIVER SOFTWARE
PROGRAMS AND/OR SCANNER UTILITY SOFTWARE PROGRAM
PROPRIETARY TO CANON OR ITS LICENSOR (THE “SOFTWARE")

AND THE ACCOMPANYING DOCUMENTATION AND OTHER ITEMS

T0 THE PLACE WHERE YOU OBTAINED THEM FOR A REFUND
BEFORE THEY ARE USED OR OPENED OR UNPACKED.

In consideration of the right to use the SOFTWARE, you agree to abide
by the terms and conditions of this Agreement.

1. GRANT OF LICENSE: Canon grants you the personal, non-
exclusive right to use the SOFTWARE only on a single computer. You
may physically transfer the SOFTWARE from one computer to another
provided that the SOFTWARE is used on only one computer at any
time.

You shall not assign, sublicense, sell, rent, lease, loan, convey or
transfer to any third party, or send or bring the SOFTWARE out of the
country where you originally obtain it to other countries without
required authorization of applicable governments, or copy, duplicate,
translate or convert to another programming language the SOFTWARE
or accompanying documentation, except as expressly provided
herein.

Except as expressly permitted under the applicable law, you shall not
alter, modify, disassemble, decompile or otherwise reverse engineer
the SOFTWARE or accompanying documentation and you also shall
not have any third party do so.

2. BACK-UP COPY: You may make one copy of the SOFTWARE
solely for a back-up purpose or copy the SOFTWARE onto the
permanent storage device (e.g. a hard disk) of your computer and
retain the original for a back-up purpose. Except as expressly
permitted under the applicable law, any other copying of the
SOFTWARE is a violation of this Agreement. You must reproduce and
include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATE: Canon, Canon’s affiliate, their
distributor or dealer is not responsible for maintaining or helping you
to use the SOFTWARE. No updates, fixes or support will be made
available for the SOFTWARE.

4. LIMITED WARRANTY AND DISCLAIMER OF INDEMNITY:
Canon, Canon’s affiliate, their distributor or dealer will not guarantee
uninterrupted service, or absence or correction of errors. Therefore,
the SOFTWARE is licensed on an “AS IS” basis without warranty of
any kind. The diskette on which the SOFTWARE is recorded is
warranted against defective material or workmanship under normal
use for a period of ninety (90) days from the date you purchased the
same as evidenced by a receipt or otherwise. The limited warranty
does not apply if the failure of the diskette resulted from accident,
abuse or misapplication of the SOFTWARE and shall not extend to
anyone other than the original user of the SOFTWARE.

CANON, CANON'S AFFILIATE, THEIR DISTRIBUTOR OR DEALER
DISCLAIMS ALL IMPLIED WARRANTIES, INCLUDING ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE OR
ACCOMPANYING DOCUMENTATION.

NEITHER CANON, CANON'S AFFILIATE, THEIR DISTRIBUTOR NOR
DEALER IS LIABLE FOR ANY LOSS OR DAMAGE INCLUDING
CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE SUCH AS
LOSS OF PROFITS, EXPENSE OR INCONVENIENCE, WHATSOEVER
CAUSED BY OR ARISING OUT OF THE SOFTWARE,
ACCOMPANYING DOCUMENTATION OR THE USE THEREOF.
CANON, CANON'S AFFILIATE, THEIR DISTRIBUTOR OR DEALER
SHALL HAVE NO OBLIGATION TO INDEMNIFY YOU AGAINST ANY
CLAIM OR SUITBROUGHT BY A THIRD PARTY ALLEGING THAT THE
SOFTWARE, ACCOMPANYING DOCUMENTATION OR THE USE
THEREOF INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH
THIRD PARTY.

THE ABOVE IS CANON'S ENTIRE LIABILITY AND YOUR EXCLUSIVE
REMEDY IN CONNECTION WITH THE SOFTWARE AND
ACCOMPANYING DOCUMENTATION.

5. TERM: This Agreement is effective upon opening the sealed disk
package and remains in effect until terminated. You may terminate this
Agreement by destroying the SOFTWARE and any copy thereof. This
Agreement will also terminate if you fail to comply with any of the
terms of this Agreement. In addition to Canon enforcing its respective
legal rights, you must then promptly destroy the SOFTWARE and any
copy thereof

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The
SOFTWARE is provided with RESTRICTED RIGHTS. Use, duplication
or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer
Software clause at DFARs 252.227-7013 or subparagraph (c) (1) and
(2) of the Commercial Computer Software Restricted Rights Clause at
FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that provision of this Agreement is
declared or found to be illegal by any court or tribunal of competent
jurisdiction, such provision shall be null and void with respect to the
jurisdiction of that court or tribunal and all the remaining provisions
of this Agreement shall remain in full force and effect.

8. ACKNOWLEDGEMENT: BY OPENING THE SEALED DISK
PACKAGE, YOU ACKNOWLEDGE THAT YOU HAVE READ THIS
AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS
AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF
AGREEMENT BETWEEN YOU AND CANON CONCERNING THE
SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER
COMMUNICATIONS BETWEEN YOU AND CANON RELATING TO
THE SUBJECT MATTER HEREQF. NO AMENDMENT TO THIS
AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED REPRESENTATIVE OF CANON.

Should you have any questions concerning this Agreement, o if you
desire to contact Canon for any reason, please write to Canon’s local
affiliate.




FCC REGULATIONS (For 120V model)

Check Reader, Model M111021

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur ina
particular installation. If this equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Use of shielded cable is required to comply with class B limits in Subpart B of Part 15 of FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If
such changes or modifications should be made, you could be required to stop operation of the equipment.
Canon U.S.A. Inc.

One Canon Plaza, Lake Success NY 11042, U.S.A.

Tel. No. (516)328-5000

RADIO INTERFERENCE REGULATIONS (For 120V models)

This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus
as set out in the interference-causing equipment standard entitled “Digital Apparatus”, ICES-003 of the
Industry Canada.

REGLEMENT SUR LE BROUILLAGE RADIOELECTRIQUE (For
120V models)

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils
numériques de Classe B prescrites dans la norme sur le matériel brouilleur: “Appareils Numériques”,
NMB-003 édictée par I'Industrie Canada.

International ENERGY STAR® Office Equipment Program
As an ENERGY STAR® Partner, CANON ELECTRONICS INC. has determined that this
' ' machine meets the ENERGY STAR® Program guidelines for energy efficiency.
W The International ENERGY STAR® Office Equipment Program is an international program
that promotes energy saving through the use of computers and other office equipment.
The program backs the development and dissemination of products with functions that
effectively reduce energy consumption. It is an open system in which business proprietors can participate
voluntarily. The targeted products are office equipment, such as computers, monitors, printers, fax,
machine, copiers, and scanners. The standards and logos are uniform among participating nations.

European Union (and EEA) only.
This symbol indicates that this product is not to be disposed of with your household waste,
according to the WEEE Directive (2002/96/EC) and your national law. This product should
be handed over to a designated collection point, e.g., on an authorized one-for-one basis
when you buy a new similar product or to an authorized collection site for recycling waste
electrical and electronic equipment (EEE). Improper handling of this type of waste could have
apossible negative impact on the environment and human health due to potentially hazardous substances
that are generally associated with EEE. At the same time, your cooperation in the correct disposal of this
product will contribute to the effective usage of natural resources. For more information about where you
can drop off your waste equipment for recycling, please contact your local city office, waste authority,
approved WEEE scheme or your household waste disposal service. For more information regarding return
and recycling of WEEE products, please visit www.canon-europe.com/environment.
(EEA: Norway, Iceland and Liechtenstein)

Fiir EMVG
Dieses Produkt ist zum Gebrauch im Wohnbereich, Geschéfts-und Gewerbebereich sowie in
Kleinbetrieben vorgesehen.

Model Names
The following names may be provided for the safety regulations in each sales region of the Check Reader.
CR-190i: Model M111021



Trademarks

e Canon and the Canon logo are registered trademarks, of Canon Inc.
in the United States and may also be trademarks or registered
trademarks in other countries.

* imageFORMULA is a trademark of CANON ELECTRONICS INC.

e Microsoft, Windows, Windows Vista, and Windows 7 are registered
trademarks or trademarks of Microsoft Corporation in the United
States and other countries.

¢ Microsoft product screen shot(s) reprinted with permission from
Microsoft Corporation.

e Adobe, Acrobat, and Adobe Reader are registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and
other countries.

e Other product and company names herein are, or may be, the
trademarks of their respective owners.

e Ranger is a trademark of Silver Bullet technology, Inc.

Copyright

Copyright 2010 by CANON ELECTRONICS INC. Al rights reserved.

No part of this publication may be reproduced or transmitted in any form or by any means, electronic or
mechanical, including photocopying and recording, or by any information storage or retrieval system
without the prior written permission of CANON ELECTRONICS INC.

Disclaimers
The information in this document is subject to change without notice.

CANON ELECTRONICS INC. MAKES NO WARRANTY OF ANY KIND WITH REGARD TO THIS MATERIAL,
EITHER EXPRESS OR IMPLIED, EXPECT AS PROVIDED HEREIN, INCLUDING WITHOUT LIMITATION,
THEREOF, WARRANTIES AS TO MARKETABILITY, MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE OF USE OR NON-INFRINGEMENT. CANON ELECTRONICS INC. SHALL NOT BE LIABLE FOR
ANY DIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY NATURE, OR LOSSES OR
EXPENSES RESULTING FROM THE USE OF THIS MATERIAL.

CANON ELECTRONICS INC. IS NOT LIABLE FOR THE STORAGE AND HANDLING OF DOCUMENTS
SCANNED WITH THIS PRODUCT, OR THE STORAGE AND HANDLING OF THE RESULTING SCANNED
IMAGE DATA.

IF'YOU INTEND TO DISCARD THE ORIGINALS OF THE SCANNED DOCUMENTS, YOU ARE
RESPONSIBLE FOR INSPECTING THE SCANNED IMAGES AND VERIFYING THAT THE DATA IS INTACT.
THE MAXIMUM LIABILITY OF CANON ELECTRONICS INC. UNDER THIS WARRANTY IS LIMITED TO THE
PURCHASE PRICE OF THE PRODUCT COVERED BY THE WARRANTY.




INTRODUCTION

Thank you for purchasing the Canon Check Reader CR-190i.

Please read this manual thoroughly before using the machine in order
to familiarize yourself with its capabilities, and to make the most of its
many functions.

Manuals for the CR-190i

The following manuals are provided with the CR-190i. Be sure to read
these manuals thoroughly before using the scanner. (The Installation
Guide and the Operation & Maintenance Guide are extracted from the
Instructions.) Electronic manual is stored as a PDF file on the supplied
Setup Disc and requires Adobe Reader to open. (You can download
Adobe Reader from the Adobe Web site.)

Installation Guide (Supplied with the scanner/Electronic Manual)

Describes the procedure for setting up the CR-190i for scanning. Set
up the CR-190i in accordance with the Installation Guide. For details on
the CR-190i, refer to the Instructions (electronic manual).

Operation & Maintenance Guide (Supplied with the scanner/
Electronic Manual)

Describes the basic operations for using the CR-190i, troubleshooting,
and maintenance. For details on the settings of the CR-190i, refer to the
Instructions (electronic manual).

Instructions (Electronic Manual): This Manual

Describes how to use the scanner, and includes instructions for
configuring the scanner settings, as well as handling, maintenance,
and troubleshooting information.

Symbols Used in This Manual

The following symbols are used in this manual to explain procedures,
restrictions, handling precautions, and instructions that should be
observed for safety.

A warNING

Indicates a warning concerning operations that may lead to death or
injury to persons if not performed correctly. To use the machine safely,
always pay attention to these warnings.

A caution

Indicates a caution concerning operations that may lead to injury to
persons, or damage to property if not performed correctly. To use the
machine safely, always pay attention to these cautions.

© wroRrTANT
Indicates operational requirements and restrictions. Be sure to read

these items carefully to operate the machine correctly, and avoid
damaging the machine.

NOTE

Indicates a clarification of an operation, or contains additional
explanations for a procedure. Reading these notes is highly
recommended.
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Important Safety Instructions

Handling

A WARNING

Never install and operate the scanner near flammable substances,
such as alcohol, paint thinner, benzene, or any other type of volatile
solution.

Never damage or modify the power cord, and never place heavy
objects on the power cord.

Always make sure that your hands are dry when you are handling
the power cord or power plug. Never grasp the power plug when
your hands are wet.

Never plug the scanner into a multiplug power strip.

Never bundle, wrap, or tie the power cord around itself or another
object. Connect the power plug securely into the power outlet.

Use only the power cord and power plug provided with the scanner.

Never attempt to disassemble or modify the scanner.

Never use flammable aerosol products near the scanner.

Before you clean the scanner, turn the power OFF and disconnect
the power cord from the power outlet.

To clean the scanner’s exterior, use a firmly wrung cloth, moistened
slightly with water or mild detergent. Never use any type of volatile
solution, such as alcohol, benzene or paint thinner.

If you hear strange sounds, detect smoke or abnormal heat, sense
vibration, or smell odd odors around the scanner, turn OFF the
power switch immediately and disconnect the power cord from the
power outlet. Contact your local authorized Canon dealer or service
representative to have the scanner serviced.

Handle the scanner with care. Avoid shock and vibration to the
scanner caused by reckless handling. If you suspect the scanner
has been accidentally damaged, turn OFF the power switch
immediately and disconnect the power cord from the power outlet.
Contact your local authorized Canon dealer or service
representative to have the scanner serviced.

Before you move the scanner, always turn OFF the power and
disconnect the power cord from the power outlet.

A cauTioN

To avoid damage to the scanner, never place the scanner on an
unstable or vibrating surface. The scanner may tip or fall over,
causing injury.

To avoid overheating and causing a fire, never block the air vents on
the back of the scanner.

Keep all liquids, beverages, or any type of liquid, and clips, staples,
necklaces, or other metal objects away from the scanner. If you
accidentally spill liquid or drop a metal object into the scanner, turn
OFF the power immediately and disconnect the power cord from the
power outlet. Contact your local authorized Canon dealer or service
representative to have the scanner serviced.

Never install the scanner in humid or dusty locations. Doing so may
cause a fire or electrical shock.

Never place heavy objects on top of the scanner, as these objects
may tip or fall over, and cause injury.

When you remove the power cord, grip it by the power plug head.
Never attempt to disconnect the power cord from the power outlet
by pulling on the power cord. Doing so may damage or expose the
cord’s internal wiring, and cause a fire or electrical shock.




B Keep the area around the power outlet clear of all obstacles so you
can disconnect the power cord easily at all times.

B Never spill water or volatile solutions (alcohol, benzene, paint
thinner) into the scanner. Doing so may cause a fire or electrical
shock.

B When the scanner is not being used for a long period of time,
disconnect the power cord from the power outlet.

B Avoid wearing loose fitting clothing, dangling jewelry, long ties, or
long hair that could become entangled with moving parts, especially
the rollers that feed paper into the scanner. If such objects become
entangled, immediately disconnect the power plug from the power
outlet to stop the scanner.

B Be careful when you are loading a document or clearing a paper
jam. It is possible that the paper edges may cut your fingers.

B Do not open the Maintenance Cover while the scanner is operating.
Doing so may result in a malfunction or injury.

B Do not touch the pins and contacts on the scanner’s connector with
your hands. Doing so may result in a malfunction.

B Do not touch anything except the operation buttons when the jogger
is operating or documents are being fed.

Installation Location

3.9' (100 mm)I

14" (356 mm)

18.3" (466 mm)

27.8" (706 mm)

For operation, maintenance, and ventilation, make sure that there is
enough space around the scanner, as shown in the illustration above.

Avoid placing the scanner in the following places. It may cause a

malfunction and adversely affect the scanner or your computer.

® Places exposed to direct sunlight
If installation in such places is unavoidable, provide a curtain or
similar object to shade the scanner.

e Places subject to dust and fumes
Dust and cigarette fumes adversely affect the components inside the
scanner.

e Near running water, a heat source, water vapor, or in an area, such
as a laboratory exposed to ammonia gas, paint thinner, or other
volatile chemicals

® Places subject to excessive vibration and shock



® Places subject to rapid changes in temperature or humidity
Condensation occurring inside the scanner may impair image
quality. Place the scanner in a room that is within the following range:
Room temperature: 50°F to 90.5°F (10°C to 32.5°C)
Relative humidity: 20% to 80% RH
Use the recommended operating environment for the ink cartridge
when using the imprinter.

* Near electronic equipment or heavy equipment that generates a
strong magnetic field, such as a speaker, TV, and radio

Power Supply

e Connect only to a power outlet of the rated voltage and power supply
frequency (either 120 V, 60 Hz or 220-240 V, 50/60 Hz, depending on
your region).

e Make sure that the scanner is connected to an independent power
outlet. Do not plug the scanner into an outlet shared with another
device. If you use an extension cord, make sure that the extension
cord is rated for the current requirements of the scanner.

e |f you are unsure of anything relating to the power supply, contact
your local authorized Canon dealer or service representative for
further information.

* Never place an object on top of the power cord or step on the power
cord.

¢ Never bundle the power cord or wrap the cord around an object,
such as a table leg.

¢ Do not tug on the power cord. When you remove the power cord, grip
it by the power plug head.

e Keep the area around the power outlet free of obstacles.

Moving the Scanner

When you move the CR-190i, hold it firmly with both hands and carry it
carefully. Do not hold the scanner by the Eject Stopper. The scanner
weighs approximately 18.5 Ib (8.4 kg).

A\ warnING

When moving the scanner, be sure to turn OFF the power and
remove any cables. If the cables are not removed before moving
the scanner, you may damage the plugs or connector by forcibly
pulling them out.




Introduction to the CR-190i

This chapter describes the features of the CR-190i scanner, what
comes packaged in the box, and the names and functions of parts on
the scanner.

Features of the CR-190i

The Canon Check Reader CR-190i is a scanner with magnetic heads
that can read checks and other documents that are printed with MICR
(Magnetic Ink Character Recognition) compatible fonts, and is capable
of OCR (Optical Character Recognition). The CR-190i is compact and
can handle large volumes of checks at a speed of 190 cpm.

Features

High-Speed Scanning
The CR-190i performs high-speed scans of check-size documents at
190 cpm (200 dpi resolution).

Supports Large Documents
Documents up to 4.3" x 9.6" (108 mm x 245 mm) can be scanned.

High Durability
The scanner has a high durability of 24 million scans.

Compact Size
8.4"(H)x 18.7" (W) x 10.7" (D) (214 mm (H) x 476 mm (W) x 272 mm (D))

Supports Black-and-White (Binary) and Grayscale Output

Reads MICR Characters
A magnetic head is used to scan MICR characters that have been
printed with magnetic ink or toner.

Supports OCR (Optical Character Recognition)
Character images, such as E13B, OCR-A, OCR-B, and check writer are
recognized as characters by the OCR function.

Easy to Maintain
Large Maintenance Covers make handling paper jams and cleaning
easy.

Jogger Mechanism Is Standard
A jogger mechanism, which uses vibration to align documents, comes
standard equipped with the CR-190i.

Separation OFF Mode
You can scan the following documents:
® Thick documents
e Documents that contain two or more pages together as one
document
e Documents that have a rough surface
e Duplicate forms that have sticky edges

Paper Thickness Adjustment Mechanism
Adijust the Separation Roller gap to the thickness of the paper being
fed.

Three Eject Pockets and Automatic Sorting Mechanism
The scanner has three Eject Pockets and the documents are
automatically ejected to each pocket according to sort methods. The
scanner fits various scan operations using this mechanism.



Ultrasonic Double Feed Detection and Double Feed Detect
OFF Button (Scanning Utility for CR-190i)

The scanner detects double-fed documents using ultrasonic, and can
turn OFF the function with the Function Button.

Drop-Out Color
This function enables drop-out scanning of a specific color in the
document.

Imprinter Is Standard Equipment

An imprinter mechanism, which prints text (4 lines) or a bitmap on
documents as they are scanned, comes standard equipped with the
scanner. The imprinter’s ink cartridge is not included, and must be
purchased separately. (See “About the Ink Cartridge,” on p. 23.)

Eject Pocket Full Detection (Scanning Utility for CR-190i)
Detects when any one of the three Eject Pockets is full and stops
scanning. (See “Scan Procedure,” on p. 35.)

Placing Additional Documents
You can place additional documents while the machine is scanning.

Replaceable rollers and ink disposal tank
You can replace the rollers (Pickup Roller, Feed Roller, and Separation
Roller) and the ink disposal tank.

Packaging: What Is in the Box?

Make sure that you have everything shown below. Check every item
you have removed from the box. If any items are missing, contact your
local authorized Canon dealer.

User Registration Card 2

Installation Guide
Operation & Maintenance Guide

*1 The power cord varies, according to the country of purchase.
*2 For the United States and Canada only.




Part Names

This section describes the names and functions of each part. Before you connect the CR-190i, familiarize yourself with its parts and their functions.

Front View

Operation Buttons

aarr stor Built-in Nozzle Cleaning Pad

6 é Ink Cartridge

JOG:  Uses vibration to align the documents. (Jogger) Ink cartridge is not included. Purchage the ink cartridge

Function (F): You can assign this button to any function from Roller Cover separately. (See “About the Ink Cartridge,” on p. 23.)
an application. When using the accompanying
Scanning Utility for CR-190i, switches the double
feed detection ON/OFF.

START: Starts scanning operations. Press and hold
this button during a paper jam to eject the
jammed document.

STOP: Stops scanning operations.

Power Switch

Front Maintenance Cover
Open this cover to clear paper jams or to clean
the scanner.

~———— Scanner Unit

This unit scans the documents.

Magnetic Head for MICR
Reads MICR characters that have been printed with magnetic ink.




. Scanner Unit
This unit scans the documents.

Back Maintenance Cover
Open this cover to clear paper jams or to clean the scanner.

Eject Pocket Top Cover

Documents are separated with flappers
into three pockets. (See p. 36)

Eject Stopper
Pull out the Eject Stopper to prevent
documents from falling off the output
tray.

Use this button when you want to scan the following documents (See
“Separation OFF Mode,” on p. 37.):
® Thick documents
¢ Documents that contain two or more pages together as one document
* Documents that have a rough surface
¢ Duplicate forms that have sticky edges

Adjustment Dial Cover

T
‘ Separation OFF Mode Button

Adjustment Dial

Adjust the Separation Roller gap if feeding errors
occur too frequently. (See “Adjusting the
Separation Roller Gap,” on p. 57.)




Rear View

Ink Disposal Tank Pocket

Connector
Air Vent

Power Cord Connector
Connect the power cord provided with the
scanner to this connector.

A caution
To avoid overheating and causing a fire, never block the air vents on the
back of the scanner.

Connector

e
@

USB Connector
Connect a Hi-Speed USB 2.0 compatible
cable. (See “USB Connections,” on p. 20.)

Exterior Dimensions

Units: inches (units in parenthesis are millimeters)

22.9" (581 mm) (with the eject stopper open)

18.7" (476 mm) >
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Preparation Before Use

This chapter describes how to prepare the scanner to scan
documents.

Setting Up the Scanner

Perform the following steps to set up the CR-190i. Refer to the section
for each step for details about that step.

m Check your operating environment. (See “Checking Your
Operating Environment,” on p. 18.)

v

IZ‘ Install the software. (See “Installing the Software,” on
p. 19.)
Install the Scanning Utility provided with the CR-190i.

v

@ Connect the scanner to a computer. (See “Connecting
the Scanner to a Computer,” on p. 20.)

v

E Turn ON the power. (See “Turning ON the Power,” on

p.21.)
v

E‘ Automatically installing the device driver. (See p. 22.)
The device driver is installed automatically when Windows
recognizes the CR-190i.
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« To have the device drivers installed automatically when the computer
recognizes the CR-190i, the software needs to be installed before the
CR-190i is connected to the computer.

« If you connect the computer and turn ON the CR-190i before installing the
software, the following wizard screen appears. If this happens, click
[Cancel], turn OFF the CR-190i, and then install the software.

The following wizard screen is an example in Windows Vista. When a
similar wizard screen appears in Windows XP/7, click [Cancel].

[37] Found New Hardware &J

Windows needs to install driver software for your CANON
CR-190i

@ Locate and install driver software (recommended)
Windows will guide you through the process of installing driver software
for your device.

* Ask me again later
Windows will ask again the next time you plug in your device or log on.

® Don't show this message again for this device
Your device will not function until you install driver software.

Cancel

Wizard Screen (Windows Vista)




Checking Your Operating Environment

The following computer system requirements are recommended for
using the CR-190i.

Operating Systems:

¢ Microsoft Windows XP (32bit) SP3 or later

¢ Microsoft Windows XP (64bit) SP2 or later

¢ Microsoft Windows Vista (32/64bit) SP1 or later
* Microsoft Windows 7 (32/64bit)

Specifications:

e CPU: Intel Core2 Duo 3.0 GHz or faster
e Memory: 1 GB or more

e USB 2.0 interface

Interface Cable
¢ Use the cable provided or a Hi-Speed USB 2.0 interface cable to
connect to the computer’'s USB port.
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« If you use the USB interface that was provided as standard with your

computer:

« Use the most recently available USB 2.0 driver provided by Microsoft.
Contact your local authorized Canon dealer for more detailed
information.

« Not all USB interfaces provided as standard with personal computers
are guaranteed. Contact your local authorized Canon dealer for more
detailed information.

« Scanning speeds are slower if your computer’s standard USB interface
is USB 1.1.

< You should use the USB cable originally bundled with the scanner or a
Hi-Speed USB 2.0 compatible cable.

If the CPU, memory, interface card, and other specifications do not satisfy

the installation requirements, the scanning speed may be greatly reduced

and transmission may take longer.

Even if the computer satisfies the recommended specifications, the

scanning speed may vary, depending on the scan settings.



Installing the Software

The following software applications are provided on the setup disc that
is packaged with the scanner. Make sure to open and read the
Readme.txt file on the setup disc before installing the software.

Scanning Utility
Canon Scanning Utility is an application that provides scanning, file
saving, image viewing, printing, and various other functions. A
dedicated scanner driver is installed after you install the utility
software.

Ranger
Ranger is an API software. For details, see “About the Ranger,” on
p. 27.
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« The Scanning Utility includes a device driver so that Windows can
recognize the CR-190i. Be sure to install the Scanning Utility before
connecting the CR-190i to the computer.

« Some functions mentioned in this manual may not be operated in some
applications.

Installing the Scanning Utility
Follow the instructions below to install the Scanning Utility and the
dedicated driver.

NOTE

The dedicated scanner driver is installed after the Scanning Utility has been
installed.

m Turn ON your computer, and log on to Windows.
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Be sure to log on as the Administrator.

@ Insert the setup disc into the CD-ROM drive.
This manual assumes that “D” is assigned to your CD-ROM drive.

@ Click [Start], and then click [All Programs].
The procedure in Windows XP/7 is different from the ones
described in this manual. Refer to the Windows XP/7 “Help and
Support Center” to select [Run].

»  All Programs

|Sfcm Search




E Click [Accessories], and then click [Run].

£ Windows Update

Calculator

B8 Cornmand Prompt

@2 Connect to a Network Projector
7| Notepad

W Paint

m

Accessories

‘mi Remote Desktop Connection
157 Run
% Snipping Tool

@ Enter “D:\SU190i\setup.exe” in the [Open] fields, and then

click [OK].
= Run [
7= Typethe name of s program, folder, document,ortemet
resource, and Windows wil open it for you
Open (D ASUL90R setup.exe .)
( ox ) cna Browse..

Installation starts.
@ Follow the instructions on the screen to complete the
installation.
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The computer may need to be restarted, after the installation, depending on

the operating system. If this is necessary, make sure to restart the computer.

Connecting the Scanner to a Computer

The only way to connect the scanner to your computer is with a USB cable.

A\ cauTion

* Do not turn OFF the scanner or remove the interface cable when an
application is running.
* Turn OFF the computer and the scanner before changing the cable.

USB Connections

Connect the scanner and the computer with the cable provided or a
Hi-Speed USB 2.0 cable.

Type A Plug Type B Plug
< =]
= &7
USB Cable
USB Connector i//@

NOTE

Connect the type B plug (square) to the scanner and connect the type A plug
(flat) to the USB port on the computer.



Connecting the Power Cord
Connect the power cord.
Make sure to use only the power cord provided with the scanner.

A\ warnING

When connecting the power cord, follow these precautions. Failure to
do so may cause a fire or electrical shock.

Never grasp the power plug when your hands are wet.

Never plug the scanner into a multiplug power strip.

Never bundle or tie the power cord around itself or another object.
Connect the power plug securely into the power outlet.

Use only the power cord and power plug provided with the scanner.

Connect only to a power outlet of the rated voltage and power supply
frequency (either 120 V, 60 Hz or 220-240 V, 50/60 Hz, depending on
your region).

Do not plug the scanner into a power outlet shared with another
device. If you use an extension cord, make sure that the extension
cord is rated for the current requirements of the scanner.

Before you connect the power cord, make sure to turn OFF the power switch.

Turning ON and OFF the Power

Follow the procedures below to turn the scanner power ON and OFF.

Turning ON the Power

m To turn ON the scanner, press the Power Switch to the “ | ”
position.
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« When you turn ON the power, the power LED lights and remains lit.

« If the scanner does not work, or the power LED continues to flash, there is
a problem with the scanner. Turn OFF the power, and contact your local
authorized Canon dealer or service representative to have the scanner
serviced.

A\ warNING

If you hear strange sounds, detect smoke or abnormal heat, sense a
vibration, or smell odd odors around the scanner, turn OFF the power
immediately and disconnect the power cord from the power outlet.
Contact your local authorized Canon dealer or service representative to
have the scanner serviced.




@ Turn ON your computer.

@ Windows recognizes the CR-190i as new hardware, and
installation starts automatically.

2 vl i x
{ ° Installing device driver software X > { :"6 CANON CR-190i USB
Click here for status. S Device driver software installed successfully.

(Windows Vista)

The CR-190i will be registered as “CANON CR-190i USB” in the Imaging
Device directory.

&) Device Manager | ]|

File Action View Help

e @B HElE RgSs

o A
-8 Computer
-y Disk drives
)-8 Display adapters
e DVD/CD-ROM drives
(- Floppy disk drives
ek Floppy drive controllers
#)-5 IDE ATA/ATAPI controllers
£)-75) Imaging deviees

& CAoN itz Us]

8- Keyboards

Turning OFF the Power
m Turn OFF your computer.

IZ‘ To turn OFF the scanner, press the Power Switch to the “ & ”
position.

A\ caution

* Wait at least 10 seconds before turning the scanner back ON.

* For your safety, disconnect the power plug from the power outlet if
you are not using the scanner for a long period of time.



Preparing the Ink Cartridge

This section describes how to prepare the ink cartridge so that you can
use the imprinter to print text or a bitmap on scanned documents.

About the Ink Cartridge

The ink cartridge is not included with the scanner. Purchase an ink
cartridge separately, as shown below.

Compatible ink cartridges: Canon ink cartridge PG-50 Black
(0616B002) or PG-40 Black (0615B002)
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These ink cartridges are available for 5 years after production has stopped.

Setting the Ink Cartridge and Adjusting

the Print Position

The ink cartridge needs to be set to print. Set the ink cartridge
according to the following procedure. You can adjust the print position
to two different levels.
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To set the ink cartridge, turn the scanner OFF before removing the Top
Cover. After the ink cartridge is set, replace the Top Cover, and then
turn the scanner back ON.

m Remove the Top Cover.

IZ' Squeeze the Print Position Adjustment Lever, and push it
down to the bottom position.




@ Place the ink cartridge shown in the diagram below. 0 IMPORTANT

Make sure that the ink cartridge is securely in place.

IE Squeeze the Print Position Adjustment Lever and move it to
adjust the print position.

Top:
1.92" (48.8 mm) from the
bottom edge of the
document

Bottom:
1.17" (29.6 mm) from the
bottom edge of the
document

A cauTion

Do not touch the electrical contact on the carriage. Doing so may cause
a malfunction.

NOTE

Do not use more than one cartridge by rotation. If you do so, applications
cannot check the ink level precisely.

E Push down the ink cartridge until it clicks into place.




Software

This chapter describes how to use the Scanning Utility and the Ranger. |Z| Click [Scanning Utility for CR-190i].

HOW to Use the software e Default Programs T

@ Internet Explorer
This section describes how to start up the Scanning Utility so that you & Scanning Utility for CR-190i
can use the scanner. Read the Help files for the Scanning Utility for Windows Calendar
information on how to use it. Windows Contacts
- B Windows Defender
HOW tO Use the scal‘lhihg Utillty &3 Windows Live Messenger Download
This section describes the procedure for using the Scanning Utility. 5] Windows Mail
Read the [Help] file in [Scanning Utility] for more information. Windows Media Player |
[@] Windows Meetina Snace =

|I| Click [Start], and then click [All Programs]. E
Start the Scanning Utility.




The basic operation of the Scanning Utility is noted in the Scanning Utility
help file. On the [Help] menu, click [Help] to view the explanation.

‘g Scanning Utility for CR-190i -

File View Page Options
= i_-=' About...
Help
Image Info...

E Select [Scanner Setting] from the [File] menu.

¥ Scanning Utility for CR-190i -
File| View Page Options Help

Open...

Save Page As..

Print

Print Format »
Printer Setting...

Scanner Setting...
Scan Page

Scan Batch to File..
Scan Batch to Printer...

Cancel Scan

Exit

The Settings dialog box appears.

@ Set the scan conditions and click [OK].

Canon CR101 2)
et |1 st | oSt | O st | o |
e (T —
[Frmmicroa v ]
[ —
Bighiness i A

e ormg

St et w L e[
‘Scanring Side e =]
[ [ —
ot
o | _oms | e | i

NOTE

For information about the settings for the scan conditions, click [Help] on the
Settings dialog box to open the Help file.



@ Select the scanning method from the [File] menu and start
scanning.

¥ Scanning Utility for CR-190i -
Open. |
Save Page As...
Print
Print Format 13

Printer Setting...

Scanner Setting...

Scan Page
Scan Batch to File..
Scan Batch to Printer..

Cancel Scan

Exit

When scanning is finished, click [Exit] on the [File] menu to
quit the Scanning Utility.

¥ Scanning Utility for CR-190i -

[File] View Page Options Help

Print Format v
Printer Setting...

Scanner Setting...
Scan Page

Scan Batch to File...
Scan Batch to Printer...

Cancel Scan

Exit

How to Use the Ranger

About the Ranger

Silver Bullet Technology’s Ranger™ Transport API software, allowing it
to be easily integrated into existing systems or be mixed and matched
with a wide range of leading check processing software.

Installing the Ranger
Follow the instructions below to install the Ranger.

II' Turn ON your computer, and start Windows.
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Be sure to log on as the administrator.

IZ' Insert the setup disc into the CD-ROM drive.
This manual assumes that “D” is assigned to your CD-ROM drive.




@ Click [Start], and then click [All Programs].
The procedure in Windows XP/7 is different from the ones
described in this manual. Refer to the Windows XP/7 “Help and
Support Center” to select [Run].

»  All Programs

|5fm1 Search

F - e
e M=

E Click [Accessories], and then click [Run].

£ Windows Update
| Accessories
7 Calculator
B8 Cornmand Prompt
@2 Connect to a Network Projector
j Motepad
4 Paint
!-!. Remote Desktop Connection

m

i3] Run
’%& Snipping Tool

@ Enter “D:\Rangen\setup.exe” in the [Open] field, and then click
[OK].

= Run =
/) Type the name of  program, folder, document, orntemet
] ¢&source, and Windows will open it for you.
Qpen: (D:\Ra ngerisetup.exel v)
(o« ) concel ][ Bowse. |

Installation starts.

@ Follow the instructions on the screen to complete the
installation.
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The computer may need to be restarted, after the installation, depending on
the operating system. If this is necessary, make sure to restart the computer.



Uninstalling the Software

This section describes how to uninstall the Scanning Utility and the
Ranger.
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« Be sure to log on as the Administrator.

» The procedure in Windows XP/7 is different from the ones described in this
manual. Refer to the Windows XP/7 “Help and Support Center” to uninstall
the software.

m Click [Start], and then click [Control Panel].

trol Panel

Default Programs

All Programs Help and Support

T
P ——— et

P

@ Double-click the [Programs and Features] icon.

B

T [sear &

CO-H omrm s

The [Programs and Features] dialog box appears.

@ Select the software that you want to remove from the list in the
dialog box, and then click [Uninstall].

(= [ [t

@ [ » Control Panel » Programs and Features ~ [ 43| [searen Ell

Uninstall or change a program

To uninstall 2 program, select it from the list and then click "Uninstall", "Change”, or "Repair’s

Otganize + [T Views | B Uninstall | ¥ Change @

(digital lock Name - Publisher Installed O
) TumWindowsfesturesonor (IS R R e BE Canon Electronics 1/8/2010
o “&Scanning Utilty For CR-190i Canon Electronics 1/8/200

NOTE

When the [User Account Control] dialog box appears, click [Continue].
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« If you uninstall the “Scanning Utility for CR-190i” you also need to uninstall
the “Canon Driver for CR-190i.”
« If you uninstall the Ranger, select the “Ranger for CR-190i.”

E The [Confirm File Deletion] dialog box appears.

Canon CR-130i Driver Setup @’

Do you want to completely remave the selected application and all of its festures?

If you selected “Canon Driver for CR-190i,” the above dialog box
appears.

E‘ Click [Yes], and the uninstaller starts.
Follow the instructions on the screen to finish uninstalling the software.




Document Feeding and Scanning

This chapter describes precautions regarding documents that can be
handled on this scanner and scanning operations.

This section describes the types of documents that can be used and
how to place them.

A\ cauTion

Treat the documents carefully. The paper edges may cut your
fingers.

Document
The CR-190i can feed a wide variety of document sizes. The ranges of
height and length for a document are:

Height : 2.7" to 4.3" (68 to 108 mm)

Length : 4.7"t0 9.6" (120 to 245 mm)

Thickness : 0.003" to 0.008" (0.08 to 0.20 mm)

Weight : 17 to 40 Ib bond (64 to 157 g/m?)

Length

Follow these guidelines when you prepare a document for scanning:
¢ Before scanning documents that contain pasted artwork, make sure
that the ink or paste is thoroughly dry. If the documents are scanned
with wet ink or paste, the inside of the scanner may become dirty and
it may cause a malfunction.

If you scan a document written in pencil, the letters may not be
scanned properly or the pencil may rub off onto the rollers and stain
subsequent documents. Before you scan this kind of document,
make a copy, and then scan the copy. After scanning a document
written in pencil or some other soft writing material, be sure to clean
the scanning rollers. (See “Cleaning the Scanning Glass and
Rollers,” on p. 45.)

If you scan thin paper in the Duplex mode, the ink printed on the back
side may be scanned. If this happens, adjust the scanning density.
Scanning documents with a rough surface may not feed easily, and
may cause friction between the documents, resulting in a feeding
error. If this happens, feed the documents one by one.

To avoid paper jams, damage to documents, and a scanner
malfunction, do not feed the following types of paper into the
scanner. If you want to scan these types of paper, first make a copy,
and then scan the copy.




Carbon backed
paper

Wrinkled or creased
paper

Coated paper or fax

Curled paper recording paper

Torn paper Extremely thin paper

Paper with clips or
staples

Paper with binding
holes

DR0E

NOTE

« Note that mixing documents of different thickness may cause a
malfunction during feeding.

« Curled, wrinkled, or folded documents may cause an error. If this happens,
straighten out the curls, or reduce the number of documents loaded.

Envelope

You can also scan the envelope. When using separation OFF mode,
you can scan an envelope with thickness up to 0.02" (0.5 mm) or weight
up to 111 lbo bond (413 g/m?).

NOTE

« Disable the double feed detection function. (See “Using Ultrasonic Double
Feed Detection,” on p. 33.)

« If the envelope is not the first document in the batch, it may cause a
feeding error or a paper jam.

= Some type of envelope may cause a feeding error or a paper jam.



Using Ultrasonic Double Feed Detection
The double feed detection function that the scanner is equipped with
uses the penetration of ultrasonic waves to detect when two or more
documents are fed at the same time.

If false detections happen too often, disable the double feed detection
function.

NOTE

When Using the Accompanying Scanning Utility for CR-190i:
You can disable the double feed detection function to push the Function
Button. When the function is disabled, the light of the Function Button is
off.




Placing Documents

Note the following points when placing documents on the scanner.

¢ Place the front of the document toward you.

* Do not exceed the Load Limit Mark when placing documents in

the document tray. This may cause feeding errors or paper jams.

e Y\

Load Limit
[
Mark

—a

006 D -
J

* A maximum of 250 documents can be loaded at one time.

* Move the stopper to the edge of the document in the document
tray in accordance with the document. Otherwise, this may
cause a paper eject error.

e

f

°)

Stopper

¢ Additional documents can be placed while the machine is
scanning.
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« Align the documents and set the bottom of the documents level in the
document tray.

» Do not exceed the Load Limit Mark when placing documents. This may
cause double feed error.



Document Feeding and Scanning Scan Procedure

|I| Carefully align the edges of the document.
This section describes how to load and scan documents.
|Z| Place the first page of the document facing you, and place the

A CAUTION leading edge of the document into the scanner.

* Avoid wearing loose fitting clothing, dangling jewelry, long ties,
or long hair that could become entangled with moving parts,
especially the rollers that feed paper through the scanner. If such
objects become entangled, immediately disconnect the power
plug from the power outlet.

Check the paper stack and remove all clips, staples, pins, or any
other type of metal or plastic fastener. These objects may cause
damage to the document, a paper jam, or a scanner malfunction.
Do not touch anything except the operation buttons when the
jogger is operating or documents are being fed.

Do not touch documents that are being fed under any @ If the documents are not aligned, press the JOG Button.
circumstances. The documents that are being fed may cut your The jogger mechanism can be used to align documents.
hand.
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If you press the JOG Button when a batch of documents of various sizes
are loaded, the alignment will be incomplete, and the documents will not
be scanned in the order loaded. If you are scanning documents of various
sizes, align the leading edges of all the documents with the entry point of
feeding.

The jogger mechanism is not available for documents of less than 5.9" (150
mm) in length.

NOTE

The jogger does not work when the shutter is open. It occurs on the
following conditions:

« The STOP Button is pressed and the scanning stops.

» There are documents on the document tray when a paper jam occurs.
Remove the documents from the document tray to close the shutter. If the
jammed document remains or the Top Cover is removed, the jogger does
not work.

The jogger vibrates for 6 seconds, and then stops. Press the JOG Button
to stop the jogger.

E Adjust the Eject Stopper in accordance with the document.

@ Instruct scanning to start from the software application.

NOTE

* When Using the Accompanying Scanning Utility for CR-190i:

There are three scanning methods as follows. Follow the each instruction.

Scan 1 page

Click [Scan Page] from the [File] menu.

Scan Batch to File

@ Click [Scan Batch to File] from the [File] menu.

@ Input the File name, and then click [Save].

® Select Simplex or Duplex, and then click [Start Scanning].

Scan Batch to Printer
@ Click [Scan Batch to Printer] from the [File] menu.
@ Select Simplex or Duplex, and then click [Start Scanning].
* You can also start scanning with pressing the START Button.

IE Scanning starts.

NOTE

« If “Sort Method” is set in the software application, the document will be
ejected to one of the three Eject Pockets according to the sort methods
that have been set.

Eject Pocket 3

/_> Flapper
\ Separates documents
/14 [~ Eject Pocket 2

Eject Pocket 1

» When printing with the imprinter, ink may get on the leading edge of the
document because the documents are ejected onto the printed surface.

Ink residue Printed text or bitmap

(back side)



* When Using the Accompanying Scanning Utility for CR-190i:
Scanning is suspended and a message is displayed when the Eject
Pocket becomes full of documents. Scanning resumes when the
documents are removed from the Eject Pocket (Eject Pocket full
detection).

Scanning Utility M

_l\-l Attention Pocket full. Please empty.

Full packet: 1

Separation OFF Mode

Use this separation OFF mode when you want to scan the following
documents:

® Thick documents

* Documents that contain two or more pages together as one

document

e Documents that have a rough surface

e Duplicate forms that have sticky edges
Feed these documents one by one and press the Separation OFF
Mode Button.

—— Separation OFF
Mode Button
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For duplicate forms, load the side with the sticky edges toward the feeding
entry point.




Troubleshooting

This chapter describes the problems that might occur in the CR-190i,
and how to remedy them.

When the Scanner Is Not Recognized

The following causes and remedies describe why your computer may
not recognize the scanner.

Cause The Scanning Utility is not installed.

Remedy Install the Scanning Utility before connecting the scanner to
the computer. (See “Setting Up the Scanner,” on p. 17.)

Cause The scanner is not correctly connected to the computer.

Remedy Connect the scanner to the computer correctly. (See
“Connecting the Scanner to a Computer,” on p. 20.)

Cause The USB interface provided as standard with your
computer is not compatible with the scanner
(Connecting via USB).

Remedy Not all USB interfaces provided as standard with personal
computers are guaranteed. Contact your local authorized
Canon dealer for more detailed information. (See “Checking
Your Operating Environment,” on p. 18.)

Cause USB cable is not compatible with the scanner
(Connecting via USB).

Remedy Use the USB cable provided with the scanner. (See
“Checking Your Operating Environment,” on p. 18.)

Cause USB hubis not compatible with the scanner (Connecting
via USB).

Remedy Remove the USB hub to use the scanner. (See “Checking
Your Operating Environment,” on p. 18.)

Clearing Paper Jams

If paper has jammed, open the Maintenance Cover and remove the
jammed paper.

A cauTion

* Be careful when you clear a paper jam. You may be injured
unexpectedly. For example, the paper edges may cut your fingers, or
the document may be damaged.

* Remove all jammed sheets of paper. Paper scraps left inside the
scanner may cause a paper jam or malfunction.

|I| Remove scanned documents from the Eject Pockets.




@ Press and hold the START Button. E Press the Open Button, and push the Back Maintenance
The jammed document is ejected into the Eject Pocket. Cover open to the back.

If the above procedure does not clear the paper jam, perform the
following to remove the jammed document.

@ Pull the Open Button, and pull the Front Maintenance Cover
open to the right and left.

IE Remove the paper that has jammed.
@ Close the Back Maintenance Cover.




Close the Front Maintenance Cover in the order shown in the
diagram below.




Feeding Trouble

If the document is not fed properly or the detection functions do not
work properly, remedy the problem by checking the following
conditions.

Condition A paper jam has occurred.

Cause and e Check to make sure that the size and thickness of the

Remedy document are within the supported range of the

scanner, and if the quality of the paper is appropriate.

For cautions on handling documents, see

“Documents,” on p. 31.

Documents with rough surfaces may cause a paper

feed error to occur.

Scan one sheet at a time in the separation OFF mode.

(See “Separation OFF Mode,” on p. 37.)

Dirty or worn rollers inside the scanner may cause a

paper jam.

Clean the rollers if they are dirty. (See “Cleaning the

Scanning Glass and Rollers,” on p. 45.) Worn rollers

must be replaced. Some rollers are replaceable. (See

“Replacing the Rollers,” on p. 53.) If the rollers are not

replaceable, contact your local authorized Canon

dealer or service representative to have the scanner

serviced.

® The Separation Roller gap is too wide. Adjust the
Separation Roller gap. (See “Adjusting the Separation
Roller Gap,” on p. 57.)

Condition A double feed error occurred even though
documents are not being double fed.

Cause and
Remedy

Condition

Cause and
Remedy

Other
Causes

Condition

Cause and
Remedy

Other
Causes

Condition

Cause and
Remedy

A double feed error may occur when documents with
different thicknesses are mixed. Turn OFF the double
feed detection mode, if this happens.

MICR characters are not recognized correctly.

® The scanner cannot correctly read MICR characters if
the magnetic heads are dirty. Clean the MICR
magnetic heads. (See “Cleaning the Magnetic Heads,”
on p. 48.)

¢ |f MICR characters cannot be recognized correctly
after cleaning the heads, the MICR heads may be
worn. Contact your local authorized Canon dealer or
service representative to have the scanner serviced.

* The MICR text is on the back of the document. Load the
side with the MICR characters face up in the document
tray.

e Some of the MICR characters are scratched or missing.
Splattered MICR ink or toner may also be the problem.

The imprinter is not printing correctly (missing

imprint dots).

Ink is clogged in the ink jet nozzle. Clean the ink jet

nozzle. Cleaning the ink jet nozzle is recommended

before using the CR-190i. (See “Cleaning the Ink Jet

Nozzles,” on p. 49.)

The ink cartridge may be empty.

Documents get dirty when using the imprinter.

Ink from the imprinter has been placed on the feed path.
Clean the ink off the feed path. (See “Cleaning the Ink Jet
Nozzles,” on p. 49 and “Cleaning the Feed Path,” on

p. 43.)




When the Scanned Image Is Not

Normal

If there is a problem with the scanned image (the image is not sharp or
stripes appear), one of the following conditions may be a probable

cause. Check the following conditions, and take the appropriate action.

The scanning glass or rollers are dirty.
If the scanning glass or rollers are dirty, the dirt will appear on the
scanned image.
P Clean the scanning glass and rollers. For details, see “Cleaning
the Scanning Glass and Rollers,” on p. 45.

The scan conditions are inappropriate.
If the scan conditions are inappropriate, the scanned image will not
be sharp or will appear as dark.
P Check the brightness and other scanner settings.
If the scanned image is blurry or the document has not been
scanned at all, the brightness may be set too high.
If the scanned image appears dark, the brightness may be set too
low.
Also, check the settings on the driver and the software application.

The driver or application does not run correctly.
If the document cannot be scanned correctly even if the scan
conditions are adjusted, the driver or the application may not be
functioning correctly.
P Reinstall the driver or application.
For details on how to install the driver, see “Installing the Software,”
onp. 19.
For details on how to install the application, see the applications
instruction manual.

Other Causes
Even if the computer may be recognizing the scanner correctly, and
the driver and the application is installed correctly, scanning may
not be performed correctly. If this happens, the interface card is not
compatible. Use the recommended interface card.

If the above remedies do not rectify the problem, contact your local
authorized Canon dealer or service representative to have the scanner
serviced.



Maintenance

This chapter describes how to clean and maintain the scanner.

Daily Cleaning

To ensure high-quality image scanning, regularly clean your CR-190i
as described below.

A cauTion

Before you clean the scanner, turn OFF the scanner and computer,
and disconnect the power cord from the power outlet. Otherwise, it
may cause an electrical shock.

Never clean the scanner with any kind of organic solvent, such as
alcohol, benzene, or paint thinner. This may cause a fire and electrical
shock, or cause the exterior of the scanner to disfigure or discolor.
Never spray mild detergent or water directly on the scanning glass.
The spray could penetrate below the glass and contaminate the
internal light source and lenses.

Cleaning the Main Unit
Wipe the scanner with a firmly wrung cloth, moistened slightly with
water or mild detergent. Then, wipe off with a clean, dry cloth.

Cleaning the Feed Path

If dirt appears on scanned documents, clean the feed path. Clean the
feed path regularly.

II' Pull the Open Button, and pull the Front Maintenance Cover
open to the right and left.
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If you notice paper dust in the feed path when you open the Maintenance
Cover, clean it out with a cotton swab.




@ Press the Open Button, and push the Back Maintenance E Close the Back Maintenance Cover.
Cover open to the back.

E‘ Close the Front Maintenance Cover in the order shown in the
Iz' Wipe the feed path with a firmly wrung cloth, moistened diagram below.
slightly with water or mild detergent. Then, wipe off with a
clean, dry cloth.

Feed Path




Cleaning the Scanning Glass and Rollers
If stripes appear on scanned images or if dirt appears on scanned
documents, clean the scanning glass and rollers. Clean the scanning
glass and rollers regularly.

II' Remove the Top Cover.

IZ‘ Pull the Open Button, and pull the Front Maintenance Cover
open to the right and left.
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If you notice paper dust in the feed path when you open the Maintenance
Cover, clean it out with a cotton swab.

@ Press the Open Button, and push the Back Maintenance
Cover open to the back.




@ Spin the rollers while wiping them clean with a firmly wrung @ Use cotton swabs that are commerecially available to clean the
cloth dampened with water or a mild detergent. entire scanning glass.
There are 26 roller positions, as shown in the diagram below.

Scanning Glass

NOTE

Use cotton swabs to clean the rollers in locations that are too narrow for
your fingers.

Roller in position 3 is turned by the roller in position . Turn the roller in
position (D to wipe the rollers.

Rollers in positions (®), ), and @ are turned by the roller in position .
Turn the roller in position @) to wipe the rollers.

Rollers in positions @) to @ are turned by the roller in position @. Turn the
roller in position @3 to wipe the rollers.

Rollers in positions () to (3 are replaceable. (See “Replacing the Rollers,”
onp. 53.)




Close the Front Maintenance Cover in the order shown in the
diagram below.

Carefully replace the Top Cover.
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If paper jams and double feeds (two papers being fed at the same time) still
occur after cleaning the rollers, the rollers may be worn. The rollers need to
be changed. Some rollers are replaceable. (See “Replacing the Rollers,” on
p. 53.) If the rollers are not replaceable, contact your local authorized Canon
dealer or service representative to have the scanner serviced.




Cleaning the Magnetic Heads

If the magnetic heads are dirty, then MICR characters cannot be
scanned correctly. Periodically, clean the magnetic heads with a
commercially available audio head cleaner.

m Pull the Open Button, and pull the Front Maintenance Cover
open to the right and left.
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If you notice paper dust in the feed path when you open the Maintenance
Cover, clean it out with a cotton swab.

@ Use a commercially available audio head cleaner to clean the

magnetic heads.
The magnetic heads are located in the
diagram below.

positions shown in the

| _—Magnetic Heads

@ Close the Front Maintenance Cover i
diagram below.

n the order shown in the




Cleaning the Ink Jet Nozzles

Ink that collects around the ink jet nozzles may stain your documents
or cause the text or bitmap to appears as scratched. Clean the area
around the ink jet nozzles periodically. Cleaning the ink jet nozzles is
also efficient action when the printed text or bitmap becomes faint.

m Remove the Top Cover.

IZ' Remove the ink cartridge.

For more information, see “Replacing the Ink Cartridge,” on p. 51.

@ Use the Built-in Nozzle Cleaning Pad to remove the ink from
around the ink jet nozzles.
Swipe the ink cartridge 2 or 3 times on the Built-in Nozzle
Cleaning Pad shown in the diagram below. If the text or bitmap
still appear faint after this operation, replace the ink cartridge
(See “Replacing the Ink Cartridge,” on p. 51.)

Built-in Nozzle Cleaning Pad

E Set the ink cartridge.
For more information, see “Setting the Ink Cartridge and
Adjusting the Print Position,” on p. 23.

IE Carefully replace the Top Cover.




Cleaning with the Cleaning Cards
(U.S.A. Only)

If a black stripe appears on the back-side of scanned images or if dirt
appears on the paper documents upon scanning or for preventative
measures, we recommend that you clean your Canon CR-Series
scanner as needed with a cleaning card. Using a cleaning card will
minimize the frequent cleaning as instructed in this manual.

It is best to perform a cleaning at beginning or end of the day. A
cleaning card does not clean the ink jet nozzles, so please remove the
ink cartridge and perform a nozzle cleaning (See “Cleaning the Ink Jet
Nozzles,” on p. 49.)
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e This operation is for U.S.A. Cleaning cards are available only in U.S.A.

e Contact your local authorized Canon dealer or service representative
for the available cleaning card.

m Turn OFF the scanner.
|Z| Disconnect the scanner and the computer.

@ Turn ON the scanner with pressing the START Button and the
STOP Button.

NOTE

If the scanner turned ON properly, the power LED continues to flash.
E Pull the Eject Stopper.

@ Place the cleaning card in the document tray.

Press the START Button to start cleaning.

N [o]

Please repeat steps 5 and 6.

A typical cleaning is feeding the cleaning card 3 to 7 times. If the
scanner is extremely dirty, you may need to use another cleaning
card.

Turn OFF the scanner.

(][]

Connect the scanner and the computer.

NOTE

* You cannot scan the document without the computer.
« Allow 1to 2 minutes for the moisture on the Canon CR-Series scanner from
the cleaning card to thoroughly dry before scanning documents.



Make the following adjustments to maintain scanning quality.

Replacing the Ink Cartridge

The ink cartridge needs to be replaced if the printed text becomes
scratchy or faint even if you have cleaned the ink jet nozzle. Replace
the ink cartridge according to the following procedure below.
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¢ The ink disposal tank must be replaced when the ink cartridge is
replaced.

¢ To replace the ink cartridge, turn the scanner OFF before removing
the Top Cover. After the ink cartridge is set, replace the Top Cover,
and then turn the scanner back ON.

NOTE

« Use a Canon ink cartridge. (See “About the Ink Cartridge,” on p. 23.)
» Do not use more than one cartridge by rotation. If you do so, applications
cannot check the ink level precisely.

m Remove the Top Cover.

@ Squeeze the Print Position Adjustment Lever, and lift it up to
the top position.

@ Push the ink cartridge backward, and then remove the ink
cartridge.

A caution
Do not touch the ink jet nozzle right after imprinting. The nozzle may be
very hot.

E Set the ink cartridge.
For more information, see “Setting the Ink Cartridge and
Adjusting the Print Position,” on p. 23.




@ Carefully replace the Top Cover.

.
Replacing the Ink Disposal Tank

When the following conditions appear, you have to replace the ink
disposal tank according to the following procedure.

¢ When the ink cartridge is replaced.

¢ When clumpy ink appears on the ink disposal tank as shown below.

The replacement ink disposal tank is not included with the scanner.
Purchase an ink disposal tank, as shown below.

Compatible ink disposal tank: 4623B002

m Open the Ink Disposal Tank Pocket.

@ Remove the ink disposal tank.
Ink Disposal Tank

A WARNING

Do not print without the ink disposal tank. Doing so may cause a
malfunction.



NOTE

« Be careful not to get dirty with ink.
« When you discard the ink disposal tank, put it in the plastic bag in the box
of the ink disposal tank.

@ Attach the ink disposal tank.

Replacing the Rollers

When rollers are worn, paper jams and double feeds tend to occur. You
can replace the rollers (Pickup Roller, Feed Roller, and Separation
Roller) according to the following procedure.

The exchange roller kit is not included with the scanner. Purchase an
exchange roller kit separately, as shown below.

Compatible exchange roller kit: 4623B001
m Remove the Top Cover.

L,




@ Open the Feed Supporter to the left.

Feed Supporter

E Pinch the Separation Roller at the rim and the fixing lever, and

then remove it with pressing the Separation OFF Mode
Button.

Fixing Lever

/€

NOTE

If the Separation Roller is not removed easily because of the fixing lever
position, turn the Pickup Roller in anticlockwise direction by hand.

@ Pinch the Feed Roller at the rim and the fixing lever, and then
remove it.

Fixing Lever

/(




@ Pinch the Pickup Roller at the rim and the fixing lever, and Attach the Feed Roller. Align the notch on the roller axis with
then remove it. the hole on the roller.

Fixing Lever

¥

NOTE @ Attach the Separation Roller with pushing the Separation OFF
Mode Button. Align the notch on the roller axis with the hole

If the Pickup Roller is not removed easily because of the fixing lever position,
on the roller.

turn the Pickup Roller by hand.
Attach the Pickup Roller.




Close the Feed Supporter to the right.

@ Carefully replace the Top Cover.




Adjusting the Separation Roller Gap

If double feed should occur too often, adjust the Separation Roller gap
according to the following procedure.

m Slide the Adjustment Dial Cover to the left.

Adjustment Dial

. _ Turn the dial to the left to
widen the gap, and turn it
to the right to narrow the
gap.

IZ' Adjust the Adjustment Dial.
Turn the Adjustment Dial to the right 3 clicks.
If documents are not fed after the above operation, turn the
Adjustment Dial back to the left 1 click.

@ Slide the Adjustment Dial Cover to the right.

A caution

Do not use the Adjustment Dial any other time except when adjusting
the Separation Roller gap. Turning the Adjustment Dial too much may
damage the scanner.




Specifications

Scanner Specifications

Type
Document size

Document feeding
Scanning method
Light source
Scanning side
Scanning mode

Scanning resolution
(primary scan lines x
secondary scan lines)
Scanning speed
Automatic feeder capacity

Automatic document feed
capacity

Interface

Other functions

Desktop sheet feed

Height: 2.7" to 4.3" (68 to 108 mm)
Length: 4.7" to 9.6" (120 to 245 mm)
Thickness: 0.003" to 0.008" (0.08 to 0.20
mm)

Weight: 17 to 40 Ib bond (64 to 157 g/m?)
Automatic / Not separate

Contact image sensor (CMOS)

LED

Simplex/Duplex

Black-and-white, Fine text filtering, Error
diffusion, 256 level grayscale, 16 level
grayscale

100 x 100 dpi, 120 x 120 dpi, 150 x 150
dpi, 200 x 200 dpi, 240 x 240 dpi, and 300
x 300 dpi

190 cpm (American checks)

Load limit of less than 1.0" (25 mm) (within
the load limit mark)

Up to 250 sheets

Hi-Speed USB 2.0

Automatic paper size detection, Ultrasonic
double feed detection, Dropout color,
Deskew

Dimensions

Weight
Power requirement

Power consumption

Noise
Operating environment

8.4"(H)x 18.7" (W) x 10.7" (D) (214 mm (H)
x 476 mm (W) x 272 mm (D))
Approximately 18.5 Ib (8.4 kg)
AC 120V (60 Hz) or AC 220-240V (50/60
Hz)
120V model

Scanning: 56.1W or less

Sleep mode: 3.9W or less
220-240V model

Scanning: 52.8W or less

Sleep mode: 4.7W or less
Less than 72 dB
Temperature: 50°F to 90.5°F (10°C to
32.5°C)
Humidity: 20% to 80% RH

B Use the recommended operating environment for the ink
cartridge when using the imprinter.
B You can use the functions noted above if your software

supports them.

B These functioins may not work depending on your computer’s
capabilities and the software you are using.

Specifications are subject to change without notice.
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